Example: Plate with a hole

Problem description:

[image: ]
The material is elastic aluminium (E=70GPa, Poisson’s ratio=0.3). 
[bookmark: _GoBack]Use a consistent set of units (e.g. kN, mm, kg).

Preparation of the mesh
	Start LS Dyna PrePost for preparation of the mesh
	[image: ]

	It can be helpful to activate names with the icons
Activate    View > Tool bar > Text and icon (Right)
                   View > Tool bar > Text and icon (bottom)

	We shall create the mesh using a convenient meshing tool:
· Either click on the two icons Mesh and 2DMesh
Or activate   FEM > Element and Mesh > 2D Mesher
	[image: ]

	This opens a graphical tool from which we can:
· Define lines, curves, circles… for the geometry.
· Specify meshing information (no. elements, bias of meshing...) to each edge.
· Perform the meshing.
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	Create the boundary for the plate using the line option: 
· The plate dimension is 200 by 100mm.
· Use the create/delete line option with pick to mark pairs of points for each line.
· Press Apply after each line so it is a separate entity (this is helpful in the meshing later).

· The Zin and Zout options allow zooming-in and zooming-out.
· For zooming in click on a point for cantering and then Zin.
· You will then have to click Zout (repeatedly) to enlarge the view.
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	Create the circle for the hole. 
· The hole has a radius of 10mm
· Use the create/delete circle option. 
· The radius tab should be activated with 10mm.
· With the pick option to mark the center.
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	Create edges for the mesh
· Use the create/delete edge icon.
· Repeatedly click on the edges (lines and circle) and then Create to create each of the edges.
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Specifying the mesh information per edge:
· Use the No.ele/edge or Ele size option to assign required element distribution to each edge and the circle.
· Specify the required information and then click on each line in turn.
· A box with the distribution appears. If you do not like this it can be reassigned.
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	Creating the mesh:
· Activate the Mesh and Mesh area icons.
· Specify a material PID (e.g. 1).
· Activate the tab for Interior holes.
· You will also have to click on the hole and boundary for these to be identified.
· Finally, do the meshing by activating the Mesh with Holes and the mesh will appear.
· If you like the mesh Accept it. If not Reject it and change the edge values/bias values to try and make a better one.
The new mesh will also appear in the background panel ready for further assignments of loads, boundary condition, materials, etc.
	[image: ][image: ]

	Saving files:
· In the model window the Save command allows a macro command file of commands used to make the model to be saved. This could be edited or used to remake the model (it does not save the mesh). 
· Save this commend file.
· The model window can be exited leaving only the new mesh. This would be saved using Save > Save As > Save Keyword As….
· Save this mesh file.
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	This is an unstructured mesh which is satisfactory for analysis. 
Sometimes it is better to make a structured mesh where more control is needed on the edge parameters. Try the following yourself.
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Mesh for a one quarter symmetry model (of the previous plate with hole). 
This is valid if loading is symmetric and correct symmetry loading and boundary conditions are applied.
	



Size 100*50mm with 10mm radius hole. Try using your own ideas for structuring and grading the mesh.

· A structured mesh needs more lines/edges to help control the meshing.
· This could be reasonable starting point. Each line is independent and can be defined as an edge.










· You will need to thing about the grading and suitable assignment of elements to edges.
· The bias option (not used here) can help to grade the mesh so that it is progressively finer toward the notch.








· Start the meshing










· The final mesh
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Improving the mesh with bias option on the edges 
	



· Using the bias option on edges it is possible to grade the mesh (Bias values are <1 or >1 depending on the direction the line is defined).










· A typical graded mesh.





But the four generated zones are disconnected! That is, they have duplicate nodes at their boundaries. 
· Join these using the icons ELETOL and DupNod.
· A window will open allowing the model to be selected. 
· Use Show Dup Nodes to visualise the nodes and Merge Dup Nodes to merge them. 
· Finish with Done.
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Some operations for visualisation and moving
	
Try the icons (at the bottom) for different types of visualisation
[image: ]

The options allow zooming in and out, viewing options and rotations
[image: ]

The shift and right mouse key causes shifting out.
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Next steps – assigning material properties and entities (loads and boundary condition)
1. Materials properties for the plate (linear elastic for now)
2. Physical properties (thickess) – defined via a section
3. Item 1 and 2 must be linked and assigned to the plate
4. Boundary condition (for restraining it)
5. Applied loading
6. Any additional output for specific information (optional)

Assigning geometric and material properties to the plate
First the materials properties are defined as follows
	





Using the Model and Keywrd icons a new panel opens.
· Activate All
· Scroll down to MAT
· And select type ELASTIC
· Double click on ELASTIC for the simplest elastic material.
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· In the new panel enter the data for Aluminium (units kg, kN, mm, msec).
· Click Accept to store this.
· And Done to close the window.
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If you were to save the dataset so far created you will see the following new data added as material cards. Also shown is part of the elements list with element number, PID and attached nodes.
NB The material number is 1 and density 2.8E-6.
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Now the geometric (thickness) properties for the plate are defined
	Using the Model and Keywrd icons a new panel opens.
· Activate All
· Scroll down to SECTION and SHELL
· Assign a new PID using NewID (or any number you want).
· Thicknesses (1mm) is defined T1=T2=T3=T4=1
· There are other element options – use the defaults 
· Finish with Accept and Done.
	[image: ]



Finally, the materials and geometric data are linked together in so called PID’s
	Using the Model and PartID icons a new panel opens.
· Activate Assign
· Click on SECID and a list of sections appear. Double click on the desired section and its PID number is assigned.
· Repeat the same operations with MID to assign the material.
· Usually there are lists of sections and materials to be linked together in each PID.
· Finish with Apply and Done.
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If you were to save the dataset so far created you will see the following new data. Each PID links a section SECID and a material MID
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Assigning entities ( for boundary condition)

	

Using the Model and CreEnt icons a new panel opens.
· Activate Boundary
· Activate Cre
· And double click on Spc
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We shall select the required edge nodes by dragging a box over them using the mouse.
· Select Area
· And ByNode
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We shall select the required edge nodes by dragging a box over them using the mouse.
· Drag a box over the required nodes
· Enter the boundary conditions fixing x,z,Rx,Ry
· Then complete with Apply
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	If you were to save the dataset so far created you will see the following new data added as boundary condition cards. These contain a list of nodes in each defined set and the restraint conditions (1=fixed, 0=free).
	[image: ]





            Repeat these operations for the lower line of nodes which will be fixed in y, z, Rx, Ry



Assigning entities (for applied load)
Load is applied at the free end. We shall use a 1kN load distributed over all nodes. 
· For an explicit analysis any force load is usually ramped to minimise oscillations (if the analysis tries to approximate a static solution), or follows some physical short duration time history for a dynamic problem. 
· For an implicit analysis it is usually a constant static load (we shall do this first). A curve fuction with constant load 1kN is defined and applied to all nodes at the 
	
Any curve is defined with the Keywrd manage:
· Select All to see all keywords.
· Scroll down to DEFINE and CURVE.
· Double click to open the curve definition panel.
· Give a unique number for the curve (e.g.1).
· Add the required values in A1 O1 and insert.
· Finish with Done.
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The nodes at the loaded end are collected into a group, or NODE_SET
· Activate the CreEnt icon.
· Scroll down to Set Data and SET_NODE.
· Using the area option collect all loading nodes.
· Define a suitable title (for reference).
· Finish with Done

	[image: ]

	
To define the loaded nodes and assign the curve. In the Keywrd manager:
· Scroll down to LOAD and then NODE_SET
· Double click to open the new window.
· Assign NODE_SET (NSID) and load curve (LCID). The bullet tabs list stored data.
· SF is a scale factor for the load. NOTE the 1kN load is applied to each node so a total of 23kN is applied for the 23 end nodes in my example. To correct this change SF to 1/(no. nodes), in this case it is 1/23 =0.04348.  Also, SF is positive since load is tension in the positive x-direction.
· Finish with Done.
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	If you were to save the dataset so far created you will see the following new data added:
· The load application data with SF=0.04348 (or whatever your factor is).
· The new load curve.
· And the new node set containing all nodes for the loaded end.
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Lastly, various control information to specify the type of analysis is needed.
	
First, the termination times is set, which is 1.0 for this implicit analysis.

· Use the KeyWrd icon and go to CONTROL and TERMINATION
· In the new window set ENDTIM to 1.0
· Finish with Accept and Done
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Also, set the implicit control cards. Use the KeyWrd icon and do the following
· Go to CONTROL and IMPLICIT_AUTO and accept the defaults.
· Go to CONTROL and IMPLICIT_GENERAL and set IFLAG=1 for an implicit analysis.
· Go to CONTROL and IMPLICIT_SOLUTION and set NSOLV=1 for a linear analysis.
· Go to CONTROL and IMPLICIT_SOLVER and accept the defaults.
After saving the new dataset the control information shown will be saved to the analysis file.
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Run the dataset 

Results
	Read in the results file 

· File > Open > LS-DYNA Binary Plot and select the d3plot binary results file
· For example
	

	
Read in the results file 

· Activate the icons Post and State to get the window shown
· For this linear implicit analysis there are only 2 states, the initial (undeformed) and final (deformed) ones. Select the last deformed state.
· Close with Done
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For a typical stress contour plot:

· Activate the icons Post and FriComp to get the window shown
· Select Stress
· Select the contour you would like (e.g. x-stress)
· Close with Done
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For a typical displacement contour plot:

· Activate the icons Post and FriComp to get the window shown
· Select Ndv
· Select the contour you would like (e.g. x-displacement)
· Close with Done

	[image: ]






NEXT ideas
IMPLICIT
· Look at stress conc factor (for comparison to composites below)
· Convert the quarter model to full USE THIS BELOW 
· Modify BC’s and loads (keeping 1kN)
· Analyse (check comparison) – beware loads – for half and full both 
· More on output results
· Do a nonlinear elasto-plastic – needs higher load
[bookmark: _Hlk519231209]Move to orthotropic composites 
· Fibre direction and material (elastic only)
· Try some different orientation (look at Stress conc factor changes)
· Can something be don on failure ??
Move to EXPLICIT for failure /damage 
· Xxx
· Xxx
· xxx
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